S� XE "Supervisor Mode" �upervisor Mode	�			





�





Supervisor Mode





Supervisor Mode allows you to define the following:





Œ	The users allowed to use OfficeTalk and their access rights to other OfficeTalk users' diaries.


�	The resources in the workgroup.


Ž	Any groups set up inside the workgroup.


�	Workgroup-wide projects and users' access rights to them.


�	Workgroup-wide planners and users' access rights to them.


‘	The workgroup-wide task classifications.


’	Specific workgroup details such as public holidays, workgroup-wide task priority descriptions and usual workgroup working hours.


“	Frequency and times of automatic data backups.





T� XE "User List" �he User List





The User List is a list of OfficeTalk users. As a supervisor, you may add, delete and edit users. You may also specify other supervisors. Supervisors are displayed in the Users List with a � symbol next to their names. 
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User List





A� XE "Adding a User" �dding a User





You can add a new OfficeTalk user in one of four ways:





Action�
Description�
�
Press the � button above the User List.�
This brings up the User dialog box. Enter the relevant details and press OK.�
�
Select New User from the Edit menu.�
This brings up the User dialog box. Enter the relevant details and press OK.�
�
Pressing the INSERT key on the keyboard.�
The User List must have focus. You can give a window focus by clicking anywhere inside the window. Pressing the INSERT key brings up the User dialog box. Enter the relevant details and press OK.�
�
Double click the left mouse button in a blank part of the User List.�
This brings up the User dialog box. Enter the relevant details and press OK.�
�
 Any of the above actions will bring up a dialog box which will allow you to enter the user's name, login name, phone number, fax number, extension and location. You can also specify that the user should be a supervisor by clicking the Supervisor check box. In addition, you can specify the access rights of other users to this user's data. OfficeTalk allows you to specify one of five different access levels to the user's diary for every OfficeTalk user.





�





User dialog box





Field�
Description�
�
First Name�
The user's first name(s).�
�
Last Name�
The user's last name.�
�
Login Name�
This is the user's login name. When a user logs into OfficeTalk, he/she will enter his/her login name followed by his/her password. The login name is case sensitive and is restricted to 10 characters. No spaces are allowed and only alphanumeric characters are allowed i.e. [0..9], [a..z], [A..Z].�
�
Fax�
This is the user's fax number if different from the workgroup fax number. If the user works at a different site or location then the user's fax number should be entered�
�
Location�
This is the user's usual work time location. This should be entered if it is different to the location of the workgroup. Alternatively, this field could be used to represent the user's location within a workgroup, e.g. North Block.�
�
Phone�
This is the user's phone number if different from the workgroup phone number. If the user works at a different site or location then the user's phone number should be entered�
�
Ext�
This is the user's usual extension number within the workgroup.�
�
Home Phone�
This is the user's home phone number.�
�
Supervisor�
Check box which is checked if the user is a supervisor�
�
S� XE "Access Rights" �� XE "Setting Access Rights to a User" �etting Access Rights to a User





Security is often an important issue when information is being shared. For example, you may require that some users can add information to your diary and you may decide that certain users should not be able to see your diary information at all. OfficeTalk lets you specify the access rights of one user to another users diary. You may specify one of five levels of access:





		�SYMBOL 183 \f "Symbol" \s 10 \h�   No Access


		�SYMBOL 183 \f "Symbol" \s 10 \h�   Read Access


		�SYMBOL 183 \f "Symbol" \s 10 \h�   Read, Create Access


		�SYMBOL 183 \f "Symbol" \s 10 \h�   Read, Create, Edit Access


		�SYMBOL 183 \f "Symbol" \s 10 \h�   Read, Create, Edit, Delete Access





To specify different user's access to your diary, click the left mouse button on your name in the Users List and press the � button, located above the User List. This will bring up a User dialog box with your details filled out. Next bring up the access rights dialog box by pressing the � button.





�





Access Rights dialog box





The dialog box contains a list of OfficeTalk users and a set of radio buttons defining their various access rights to your diary. By default, all users have read access to your diary. If you select one of the users from the list, a radio button will be selected indicating that user's access rights to your diary. To change the selected user's access rights to your diary, click the relevant radio button. If you want to change the access rights of a group of users then select the relevant users from the list by holding down the Ctrl key while clicking on the user’s names. When you select one of the radio buttons and press OK, all the selected users will be given the corresponding access to your diary.





Note:  The access rights may only be defined once the user has been created. 


Resetting a User’s Password� XE "Resetting a  Users Password" �





If a user forgets his/her password then a supervisor can reset the users password. The supervisor can do this from Supervisor Mode by pressing the � button in the User dialog box. The password will be reset to the login name of the user. OfficeTalk will inform the supervisor that the password will change to the user’s login name.





�





OfficeTalk Message





E� XE "Editing a User" �diting a User





You can edit an existing user in several ways:





Action�
Description�
�
Using the � button.�
Select the user you wish to edit and press the � button. The User dialog will appear.�
�
Double clicking the user.�
Double click on the relevant user in the User List.�
�
Pressing the ENTER key on the keyboard.�
Select the user that you wish to edit and press the ENTER key on the keyboard. The User dialog box will appear.�
�



D� XE "Deleting a User" �eleting a User





If somebody leaves your workgroup or company then you will probably wish to remove them from OfficeTalk. Deleting an item in OfficeTalk is the process of binning the item and then shredding it. Deleting (i.e. Shredding) a user will delete the user's appointments and tasks. It will not however delete any personal projects, planners or groups that the user may have set up. The supervisor has the choice of either deleting these or reassigning their access rights so that other users may see them. 





You can bin a user in several ways:


Action�
Description�
�
Drag the user to the bin.�
Press and keep pressed, the left mouse button when the cursor is over the relevant user's name. Whilst keeping the left mouse button pressed, move the mouse over the bin and then release the left mouse button. The user will be removed from the Users List.�
�
Press the � button above the User List.�
Select the user you wish to bin and press the � button.�
�
Select Bin User(s) from the Edit menu.�
Select the user you wish to bin and select the menu option.�
�
Press the DELETE key on the keyboard.�
Select the user or users that you wish to bin and press the DELETE key on the keyboard.�
�



You can bin more than one user at a time by selecting several users from the Users List and performing the actions described above.





Binning a user will not delete the user completely. You may un-bin a user or a selection of users by opening the bin and pressing the � button. You may delete users completely by opening the bin, selecting the relevant users in the bin and pressing the � button. For more information on the Bin, see the The Bin section in the chapter called General OfficeTalk Features.
























































T� XE "Resource List" �he Resource List
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Resource List





A resource is an object in a workgroup whose time may be booked by users in the organisation. Examples of a resource are:





		�SYMBOL 183 \f "Symbol" \s 10 \h�   A Meeting Room


		�SYMBOL 183 \f "Symbol" \s 10 \h�   A Pool Car


		�SYMBOL 183 \f "Symbol" \s 10 \h�   An Overhead Projector





OfficeTalk will keep a separate diary for every resource that you define. There are two types of resources; fixed resources and non-fixed resources. A fixed resource is a resource which has a permanent location and cannot be moved, for example a Meeting Room. A non-fixed resource may be moved. An example is an Overhead Projector which may get moved between meeting rooms, for example.








A� XE "Adding a Resource" �dding a Resource





You can add a resource in one of five ways:





Action�
Description�
�
Single click the left mouse button in a blank part of the Resource List.�
An edit caret will appear. Type in the name of the resource and press ENTER. This will create a non-fixed resource with no owner.�
�
Press the � button above the Resource List.�
This brings up the Resource dialog box. Enter the relevant details and press OK.�
�
Select New Resource from the Edit menu.�
This brings up the Resource dialog box. Enter the relevant details and press OK.�
�
Using the INSERT key on the keyboard.�
The Resource List must have focus. You can give a window focus by clicking anywhere inside the window or by repeatedly pressing the F6 function key until the window has focus. Pressing the INSERT key brings up the Resource dialog box. Enter the relevant details and press OK.�
�
Double click the left mouse button in a blank part of the Resource List.�
This brings up the Resource dialog box. Enter the relevant details and press OK.�
�



If you add a resource by using either of the last four methods a Resource dialog box will appear.





�





Resource dialog box





Field�
Description�
�
Name�
The resource’s name, for example, Overhead Projector or Meeting Room 1.�
�
Default Location�
This is the usual place where the resource is kept. If the resource is a fixed resource then this field is disabled since the name of the fixed resource will represent its location, for example, Meeting Room 1.�
�
Owner�
You may specify an Owner for the resource. An owner will be informed by OfficeTalk whenever the resource is booked for a meeting. For more information on booking meetings see the Meeting Mode chapter. To specify an owner for the resource, click on the Owner pull down list and select an existing OfficeTalk user.


�
�
Fixed �
Select this check box if you wish to make the resource a fixed resource.�
�






E� XE "Editing a Resource" �diting a Resource





A resource may be edited in several ways:





Action�
Description�
�
Using the � button.�
Select the resource you wish to edit and press the � button. The Resource dialog box will appear.�
�
Double clicking the resource.�
Double click on the relevant resource in the Resource List.�
�
Pressing the ENTER key on the keyboard.�
Select the resource you wish to edit and press the ENTER key on the keyboard. The Resource dialog box will appear.�
�



D� XE "Deleting a Resource" �eleting a Resource





Deleting an item in OfficeTalk is the process of binning the item and then shredding it. Deleting a resource deletes the diary for that resource and it removes the entry from the Resource List. You can bin a resource in several ways:





Action�
Description�
�
Drag the resource to the bin.�
Press and keep pressed, the left mouse button when the cursor is over the relevant resource name. Whilst keeping the left mouse button pressed, move the mouse over the bin and then release the left mouse button. The resource will be removed from the Resource List.�
�
Press the � button above the Resource List.�
Select the resource you wish to bin and press the � button.�
�
Select Bin Resource(s) from the Edit menu.�
Select the resource you wish to bin and select the menu option.�
�
Press the DELETE key on the keyboard.�
Select the resource that you wish to bin and press the DELETE key on the keyboard.�
�



You can bin more than one resource at a time by selecting several resources from the Resource List and performing the actions described above.





Binning a resource will not delete the resource completely. You may un-bin a resource or a selection of resources by opening the bin and pressing the � button. You may delete a resource completely by opening the bin, selecting the resource and pressing the � EMBED Word.Picture.6  ��� button. For more information on the Bin, see the Bin section in the chapter called General OfficeTalk Features.





T� XE "Groups, OfficeTALK Users" �� XE "Group List" �he Group List








OfficeTalk allows you to group users and resources together and refer to the group by a single group name. User groups are used in Group Mode, Meeting Mode, Mail Mode and Notify Mode to refer to a collection of users and resources.
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Group List





A� XE "Adding a Group" �dding a Group





Adding a group in OfficeTalk involves specifying a name for the group, for example, Sales, and defining the members who will belong to that group. Both public groups and personal groups may be created. Groups may be added either from Supervisor Mode or from Group Mode.


 


There are five ways to add a group:


�



Action�
Description�
�
Single click the left mouse button in a blank part of the Group List.�
An edit caret will appear. Type in the name of the group and press ENTER. This will create a public group with no members.�
�
Press the � button above the Group List.�
This brings up the Group dialog box. Enter the relevant details and press OK.�
�
Select New Group from the Edit menu.�
This brings up the Group dialog box. Enter the relevant details and press OK.�
�
Using the INSERT key on the keyboard.�
The Group List must have focus. You can give a window focus by clicking anywhere inside the window or by repeatedly pressing the F6 function key until the window has focus. Pressing the INSERT key brings up the Group dialog box. Enter the relevant details and press OK.�
�
Double click the left mouse button in a blank part of the Group List.�
This brings up the Group dialog box. Enter the relevant details and press OK.�
�



The last four methods described above will display a Group dialog box. The dialog box contains a list of non-members and a list of members in the group. You can select one or more users from the non-members list and add them to the group by pressing the � button. Alternatively you can double click on a particular user in the non-member list. This will add the user or resource to the group. You can use the � button to remove users or resources from the group.





�





Group dialog box


E� XE "Editing a Group" �diting a Group





A group may be edited in several ways:





Action�
Description�
�
Using the � button.�
Select the group that you wish to edit and press the � button. The Group dialog box will appear.�
�
Double clicking the group.�
Double click on the relevant group in the Group List.�
�
Pressing the ENTER key on the keyboard.�
Select the group that you wish to edit and press the ENTER key on the keyboard. The Group dialog box will appear.�
�






D� XE "Deleting a Group" �eleting a Group





Deleting an item in OfficeTalk is the process of binning the item and then shredding it. Deleting or binning a group deletes or bins a grouping of users. It does not delete or bin the users belonging to the group. There are several ways to bin a group:





�
�
Action�
Description�
�
Drag the group to the bin.�
Press and keep pressed, the left mouse button when the cursor is over the relevant group name. Whilst keeping the left mouse button pressed, move the mouse over the bin and then release the left mouse button. The group will be removed from the Group List.�
�
Press the � button above the Group List.�
Select the group you wish to bin and press the � button.�
�
Select Bin Group(s) from the Edit menu.�
Select the group you wish to bin and select the menu option.�
�
Press the DELETE key on the keyboard.�
Select the group that you wish to bin and press the DELETE key on the keyboard.�
�



You can bin more than one group at a time by selecting several groups from the Group List and performing the actions described above.





Binning will not delete the groups completely. You may un-bin a group or a selection of groups by opening the bin and pressing the � button. You may delete a group completely by opening the bin, selecting the group and pressing the � EMBED Word.Picture.6  ��� button. For more information on the Bin, see the Bin section in the chapter called General OfficeTalk Features.





Note:  When you delete a group you do not actually delete any of the users or resources belonging to the group.





T� XE "Project List" �he Project List 





Projects in OfficeTalk allow you to define project tasks, display them in a Gantt chart view and assign them to OfficeTalk users. Projects which are public to several users can be added from Supervisor Mode via the Project List or directly in Project Mode.
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Project List





A� XE "Adding a Project" �dding a Project





Adding a project in OfficeTalk involves specifying a name for the project. Both public projects and personal projects may be created. Projects may be added either from Supervisor Mode or from Project Mode.





There are five ways to add a project:


�



Action�
Description�
�
Single click the left mouse button in a blank part of the Project List.�
An edit caret will appear. Type in the name of the project and press ENTER. This will create a public project.�
�
Press the � button above the Project List.�
This brings up the Project dialog box. Enter the relevant details and press OK.�
�
Select New Project from the Edit menu.�
This brings up the Project dialog box. Enter the relevant details and press OK.�
�
Using the INSERT key.�
The Project List must have focus. You can give a window focus by clicking anywhere inside the window or by repeatedly pressing the F6 function key until the window has focus. Pressing the INSERT key brings up the Project dialog box. Enter the relevant details and press OK.�
�
Double click the left mouse button in a blank part of the Project List.�
This brings up the Project dialog box. Enter the relevant details and press OK.�
�



The last four methods described above will display a Project dialog box from which you may enter the name of the project, specify the project owner and define the access of various OfficeTalk users to the project. Pressing OK will add the project.





�





Project dialog box


�
E� XE "Editing a Project" �diting a Project





A project may be edited in several ways:





Action�
Description�
�
Using the � button.�
Select the project that you wish to edit and press the � button. The Project dialog box will appear.�
�
Double clicking the project.�
Double click on the relevant project in the Project List.�
�
Pressing the ENTER key on the keyboard.�
Select the project that you wish to edit and press the ENTER key on the keyboard. The Project dialog box will appear.�
�



D� XE "Deleting a Project" �eleting a Project





Deleting an item in OfficeTalk is the process of binning the item and then shredding it. You can bin a project in one of several ways:





Action�
Description�
�
Drag the project to the bin.�
Press and keep pressed, the left mouse button when the cursor is over the relevant project name. Whilst keeping the left mouse button pressed, move the mouse over the bin and then release the left mouse button. The project will be removed from the Project List.�
�
Press the � button above the Project List.�
Select the project you wish to bin and press the � button.�
�
Select Bin Project(s) from the Edit menu.�
Select the project you wish to bin and select the menu option.�
�
Press the DELETE key on the keyboard.�
Select the project that you wish to bin and press the DELETE key on the keyboard.�
�



You can bin more than one project at a time by selecting several projects from the Project List and performing the actions described above.





Binning will not delete the projects completely. You may un-bin a project or a selection of projects by opening the bin and pressing the � button. You may delete a project completely by opening the bin, selecting the relevant project and pressing the � EMBED Word.Picture.6  ��� button. For more information on the Bin, see the Bin section in the chapter called General OfficeTalk Features.


D� XE "Defining Access Rights to a Project" �efining Access Rights to a Project





You may wish to give different users different access rights to a particular project within OfficeTalk. You can define user’s access rights to a project by pressing the access rights button within the Project dialog box.





�





Access Rights dialog box





The dialog box contains a list of OfficeTalk users and a set of radio buttons defining the various access rights to the project. If you select one of the OfficeTalk users from the list, a radio button will be selected indicating the selected OfficeTalk user's access to the project. To change the user's access to the project, click the relevant radio button. The following access rights are available:





		�SYMBOL 183 \f "Symbol" \s 10 \h�   No Access


		�SYMBOL 183 \f "Symbol" \s 10 \h�   Read Access


		�SYMBOL 183 \f "Symbol" \s 10 \h�   Read, Create Access


		�SYMBOL 183 \f "Symbol" \s 10 \h�   Read, Create, Edit Access


		�SYMBOL 183 \f "Symbol" \s 10 \h�   Read, Create, Edit, Delete Access





Note:  The access rights may only be defined once the project has been added to OfficeTalk. 


�
T� XE "Planner List" �he Planner List





A planner is used to plan background activities which will typically span one or more days. OfficeTalk lets you define many planners and allows you to specify different user access rights to each planner. For more information on planners see the Planner Mode section.
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Planner List





 A� XE "Adding a Planner" �dding a Planner





OfficeTalk lets you add public and personal planners from both the Supervisor Mode and Planner Mode. You can add a planner in one of several ways:





Action�
Description�
�
Single click the left mouse button in a blank part of the Planner List.�
An edit caret will appear. Type in the name of the planner and press ENTER. This will create a public planner.�
�
Press the � button above the Planner List.�
This brings up the Planner dialog box. Enter the relevant details and press OK.�
�
Select New Planner from the Edit menu.�
This brings up the Planner dialog box. Enter the relevant details and press OK.�
�
Using the INSERT key.�
The Planner List must have focus. You can give a window focus by clicking anywhere inside the window or by repeatedly pressing the F6 function key until the window has focus. Pressing the INSERT key brings up the Planner dialog box. Enter the relevant details and press OK.�
�
Double click the left mouse button in a blank part of the Planner List.�
This brings up the Planner dialog box. Enter the relevant details and press OK.�
�



The last four methods described above will display a Planner dialog box from which you may enter the name of the planner, specify the planner owner and define the access of various OfficeTalk users to the planner. Pressing OK will add the planner.





�





Planner dialog box





E� XE "Editing a Planner" �diting a Planner





You may edit an existing planner in several ways:





Action�
Description�
�
Using the � button.�
Select the planner that you wish to edit and press the � button. The Planner dialog box will appear.�
�
Double clicking the planner.�
Double click on the relevant planner in the Planner List.�
�
Pressing the ENTER key on the keyboard.�
Select the planner that you wish to edit and press the ENTER key on the keyboard. The Planner dialog box will appear.�
�



Editing a planner








D� XE "Deleting a Planner" �eleting a Planner





Deleting an item in OfficeTalk is the process of binning the item and then shredding it. You can bin a planner in one of several ways:





Action�
Description�
�
Drag the Planner to the bin.�
Press and keep pressed, the Left mouse button when the cursor is over the relevant planner name. Whilst keeping the Left mouse button pressed, move the mouse over the bin and then release the Left mouse button. The planner will be removed from the Planner List.�
�
Press the � button above the Planner List.�
Select the planner you wish to bin and press the � button.�
�
Select Bin Planner(s) from the Edit menu.�
Select the planner you wish to bin and select the menu option.�
�
Press the DELETE key on the keyboard.�
Select the planner that you wish to bin and press the DELETE key on the keyboard.�
�



You can bin more than one planner at a time by selecting several planners from the Planner List and performing the actions described above.





Binning will not delete the planners completely. You may un-bin a planner or a selection of planners by opening the bin and pressing the � button. You may delete a planner completely by opening the bin, selecting the planner and pressing the � EMBED Word.Picture.6  ��� button. For more information on the Bin, see the Bin section in the chapter called General OfficeTalk Features.





D� XE "Defining Access Rights to a Planner" �efining Access Rights to a Planner





You may wish to give different users different access rights to a particular planner within OfficeTalk. You can define user’s access rights to a planner by pressing the access rights button within the Planner dialog box. Defining access rights for a planner is similar to defining access rights for a project. For more details see the Project List section.


�
�� XE "Workgroup Details" �  Workgroup Details





When you press this button, a Workgroup Details dialog box appears which allows you to specify the workgroup phone, fax and location information.





�





Workgroup Details dialog box





You may not change the workgroup name since this is used by the licensing mechanism for matching against your product enabling keycode.








�� XE "Custom Day" �  Custom Day





Pressing this button will bring up a Custom Day dialog box. The dialog box shows a list of check boxes, one for each day of the week.





�





Custom Day dialog box





If any of these check boxes are not selected then this means that the corresponding day is not a usual working day. For most organisations, all the check boxes will be selected except the Saturday and Sunday check boxes. The dialog box also includes Day Start and Day End fields allowing you to define the usual start and end times of each day. OfficeTalk uses the information you provide in this dialog box when automatically scheduling appointments and booking meetings.








�� XE "Priorities" �  Priorities





Pressing this button will pop up a Priorities dialog box. OfficeTalk allows you to define up to 5 priority levels to describe the priority of a task. OfficeTalk allows you to associate each priority level with a description, making it easier for OfficeTalk users to set the priority levels of each task. 





�





Priority dialog box





OfficeTalk lets you define the default task priority. Select the radio button next to the definition that you wish to be the default priority for all tasks in OfficeTalk.





�� XE "Classifications" �  Classifications





Classifications are workgroup-wide categorising descriptions which may be associated with any task when in Diary Mode. For example you may wish to associate all tasks to do with Training. Once tasks are associated with a classification, they may be sorted by classification.





Pressing this button will pop up a Classifications dialog box. The Classifications dialog box displays a list of workgroup-wide classifications that have been defined. 





�





Classifications dialog box


To add a new Classification, press the � button in the Classifications dialog box. Another dialog box will appear allowing you to enter the classification description.





�





Classification dialog box





You can edit previously defined classifications by selecting the classification that you wish to edit from the classification list and pressing the � button. This will pop up the Classification dialog box, shown above, with the Name field filled in with the selected classification.





You can delete previously defined classifications by selecting the classification that you wish to delete from the classification list and pressing the � button.








�� XE "Public Holidays" �  Public Holidays





Pressing this button will pop up a Public Holidays dialog box. The Public Holidays dialog box displays a list of workgroup-wide public holidays that have been defined. 





�





Public Holidays dialog box





To add public holidays, press the � button in the Public Holidays dialog box. Another dialog box will appear allowing you to enter the description and date of the public holiday. 





�





Public Holiday dialog box





The dialog box, shown above, indicates how you would add Christmas Day to your list of public holidays.





The public holidays that you define are optionally displayed in your Background Activities Window (see Background Activities Window in Diary Mode chapter).





You can edit previously defined public holidays by selecting the public holiday that you wish to edit from the public holiday list and pressing the � button. This will pop up the Public Holiday dialog box, shown above, with the description and date fields filled in with the selected holiday.





You can delete previously defined holidays by selecting the holiday that you wish to delete from the holiday list and pressing the � button.





�� XE "Export Workgroup" �  Export Workgroup





This feature allows you to export your entire database as an ASCII delimited .CMP file. Use this feature when you wish to manually back-up your entire workgroup database. When you press the Export Workgroup button, an Export Workgroup dialog box will appear. Choose the directory path and name of the back-up file and press OK. 





When OfficeTalk starts up and there is no database, a Workgroup Not Found dialog box appears. 





�





Workgroup Not Found dialog box





When this dialog box appears, you have the choice of creating a new database or importing an existing database. If you press the � button, an Import Workgroup dialog box will appear. You can choose a file that you created using the Export Workgroup facility. OfficeTalk will reconstruct the database from this ASCII file.








�� XE "Who is Logged On" �  Finding Out Who is Logged On





Pressing this button lets you to see who is currently logged on to OfficeTalk. This is useful in Supervisor Mode since you may be changing data concerning a particular user, for example his/her login name, and you would prefer that they were not logged on while you were making the changes.





This button is available from other areas of OfficeTalk, however from Supervisor Mode, you have the option to log a user out of OfficeTalk. Do this by selecting the relevant user from the list of users and pressing the � button. OfficeTalk also displays the sub-directory path used to store each user's database.





�





The Who dialog box








�� XE "Validate Database" �  Validate Database





The Validate Database command lets you validate the entire OfficeTalk workgroup database. If you suspect that a database corruption has occurred, then running this command may find and even fix any problems.





When you press this button, OfficeTalk will ask you to confirm that you wish to validate the database. 





�





OfficeTalk Confirmation





When you press �, OfficeTalk will pop up a window displaying the progress of the database validation. If you wish to cancel the validation at any point then press the � button. Other users do not need to be logged off when you run this command. For large databases, this command may take several hours.








Additional Menu Commands





Most commands in the menu can be performed using the buttons in the toolbar, however there are some less frequently used commands which appear only in the menu. These are as follows:





� XE "Restore Diary" �Restore User





This feature lets you restore a specified user's diary to the last backup that the user made of his/her own diary. When you select this command from the File menu, OfficeTalk will display a Restore User dialog box. 





�





Restore User dialog box





Choose the user that you wish to restore. The date and time of when that user last did a backup is displayed. Press OK. Provided that the user is not currently logged on, the user’s personal information (appointments and tasks) will be restored.





If the user has not performed a personal backup (using the File/Backup command), then OfficeTalk will warn you of this by popping up an Information box.





�





OfficeTalk Information Box





� XE "Backing up the Workgroup Data" �� XE "Workgroup data Backup" �Workgroup Data Backup





This feature lets you specify the frequency and time of automatic workgroup backups.





IMPORTANT


	It is recommended that you backup your own personal database and the Workgroup database once a day. 





When you select the Workgroup Data Backup command which is under Options menu, a Workgroup Data Backup dialog box appears.





�





Workgroup Data Backup dialog box





If you do not want to make workgroup backups then un-check the Automatic Backup check box. You can specify the frequency of workgroup backups by specifying a number in the Every n Days field. The default is for OfficeTalk to backup the company database every day. You can specify the time at which Workgroup database backups will be made. The default is midnight.





OfficeTalk also lets you specify which user will perform the backups. You can do this by selecting the required user from the User pull down list in the Workgroup Data Backup dialog box. Workgroup data backups will only be performed if this user is logged on. Note that the user does not have to be logged on at the exact time that you ask OfficeTalk to backup the data. If a workgroup data backup is due when the specified user logs on then the backup will done shortly after the user has logged on.





OfficeTalk lets you choose the file to which the workgroup database will be backed up. OfficeTalk does this by popping up a File dialog box when the backup time arrives. When you choose a file, OfficeTalk will remember this for future backups so that it does not need to prompt you for the filename. OfficeTalk does this by adding an entry fileName={full path name} into the OTALK.INI file in the section [Backup], as shown in the example below:





			.


			.


		[Backup]


		fileName=c:\backups\otalk.cmp


			.


			.





Inserted into the OTALK.INI file





For more information on the OTALK.INI file see Appendix B (The Initialisation File).


By default, OfficeTalk will ask the selected user before performing the backup. This can be avoided by unchecking the Prompt Before Backup check box in the Workgroup Data Backup dialog box.�
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